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SI* (MODERN METRIC) CONVERSION FACTORS 

APPROXIMATE CONVERSIONS TO SI UNITS 
Symbol When You Know Multiply By To Find Symbol 

LENGTH 
in  inches 25.4 millimeters mm 
ft  feet 0.305 meters m 
yd  yards 0.914 meters m 
mi  miles 1.61 kilometers km 

AREA 
in2  square inches 645.2 square millimeters mm2 
ft2  square feet 0.093 square meters m2 
yd2  square yard 0.836 square meters m2 
ac  acres 0.405 hectares ha 
mi2  square miles 2.59 square kilometers km2 

VOLUME 
fl oz  fluid ounces 29.57 milliliters mL 
gal  gallons 3.785 liters L 
ft3  cubic feet 0.028 cubic meters m3 
yd3  cubic yards 0.765 cubic meters m3 

NOTE: volumes greater than 1000 L shall be shown in m3 
MASS 

oz  ounces 28.35 grams g 
lb  pounds 0.454 kilograms kg 
T  short tons (2000 lb) 0.907 megagrams (or "metric ton") Mg (or "t") 
oz  ounces 28.35 grams g 

TEMPERATURE (exact degrees) 
oF  Fahrenheit (F-32)/1.8 Celsius oC 

ILLUMINATION 
fc  foot-candles 10.76 lux lx 
fl  foot-Lamberts 3.426 candela/m2 cd/m2 

FORCE and PRESSURE or STRESS 
lbf  poundforce 4.45   newtons N 
lbf/in2  poundforce per square inch 6.89 kilopascals kPa 



TNM 3.2 User’s Guide 

  

iii of iiii  

SI* (MODERN METRIC) CONVERSION FACTORS 
APPROXIMATE CONVERSIONS FROM SI UNITS 

Symbol When You Know Multiply By To Find Symbol 
 LENGTH   

mm millimeters 0.039 inches in 
m meters 3.28 feet ft 
m meters 1.09 yards yd 
km kilometers 0.621 miles mi 

 AREA   

mm2
 square millimeters 0.0016 square inches in2

 

m2 square meters 10.764 square feet ft2
 

m2 square meters 1.195 square yards yd2
 

ha hectares 2.47 acres ac 
km2

 square kilometers 0.386 square miles mi2 

 VOLUME   

mL milliliters 0.034 fluid ounces fl oz 
L liters 0.264 gallons gal 
m3 cubic meters 35.314 cubic feet ft3

 

m3 cubic meters 1.307 cubic yards yd3
 

mL milliliters 0.034 fluid ounces fl oz 
 MASS   

g grams 0.035 ounces oz 
kg kilograms 2.202 pounds lb 
Mg (or "t") megagrams (or "metric ton") 1.103 short tons (2000 lb) T 
g grams 0.035 ounces oz 

TEMPERATURE (exact degrees) 
oC Celsius 1.8C+32 Fahrenheit oF 

 

lx  
ILLUMINATION 

lux 0.0929 
  

 

foot‐candles 
 

fc 

  cd/m2  candela/m2 0.2919  foot‐Lamberts       fl 
 

N 
kPa 

FORCE and PRESSURE or STRESS 
newtons 0.225 
Kilopascals 0.145 

 
poundforce per square 
inch 

 
lbf lbf/in2

 

*SI is the symbol for the International System of Units. Appropriate rounding should be made to comply with Section 4 

of ASTM E380. (Revised March 2003) 
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1. INTRODUCTION 

The Federal Highway Administration (FHWA) Traffic Noise Model (TNM) version 3.2 is a computer 

program that is used to analyze highway traffic noise to assist in the design and development of highway 

noise barriers. Roadway construction noise can also be analyzed in TNM 3.2. TNM computes the effect 

of intervening ground (defined by its type, or optionally by its flow resistivity) with theory‐based 

acoustics that have been calibrated against field measurements. In addition, TNM allows sound to 

propagate underneath elevated, on-structure, intervening roadways and barriers, rather than being 

shielded by them. During calculation, TNM perturbs intervening barriers up and down from their input 

height to calculate for multiple heights. Then, during acoustical design of selected barriers and receivers, 

TNM displays sound‐level results for any combination of barrier height perturbations. TNM also contains 

a check to determine if noise barriers break the lines‐of‐sight between sources and receivers. In 

addition, TNM provides summary cost and benefit information for each barrier design, from user‐

supplied unit barrier costs and land‐use information. For selected cross sections, TNM also computes the 

effect of multiple reflections between parallel barriers or retaining walls that flank a roadway. The TNM 

user can then enter the computed parallel barrier performance degradations as adjustment factors for 

individual receivers in TNM's calculation of receiver sound levels. 

TNM is provided by FHWA as a standalone application and includes a batch processing tool as well. This 

User Guide specifically covers the functionality provided by the TNM standalone application. 

Detailed instructions on how to operate the TNM standalone application are comprised of the following 

topics: 

• DEFAULT INTERFACE LAYOUT 

• TOOLBAR 

• LEGEND PANE 

• VIEW PANE 

• EDIT PANE: EDIT TAB 

• EDIT PANE: SEARCH AND GEOCODE TABS 

• OBJECT DETAILS PANE 

• DRAWING IN THE PLAN BUILDER 

1.1 TECHNICAL SUPPORT 

Please contact TNMHelp@dot.gov for assistance with TNM. The FHWA also provides short HOW-TO 

VIDEOS that demonstrate how to accomplish basic tasks in TNM 3.0 and 3.1 on the FHWA YouTube 

channel under the 'TNM' playlist at: 

https://www.youtube.com/playlist?list=PL5_sm9g9d4T3naH9knm5E6SZUpmI_QD3y. These tasks are 

performed similarly in TNM 3.2. New videos for TNM 3.2 will be added periodically.  

mailto:TNMHelp@dot.gov
https://www.youtube.com/playlist?list=PL5_sm9g9d4T3naH9knm5E6SZUpmI_QD3y
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2. DEFAULT INTERFACE LAYOUT 

The TNM default layout of the user interface consists of the toolbar and individual function panes, 

annotated in FIGURE 1. The mouse and keyboard are used to navigate, draw, and execute TNM noise 

modeling. The main areas in the TNM application are as follows: 

TOOLBAR 

The toolbar, located at the top of the user interface by default (Section 1 annotated in FIGURE 1), 

contains File, Edit/Modify, View, Settings, Calculate, Barrier Analysis, Contours, Reports, Tools, and Help 

tabs.  

LEGEND PANE 

The Legend Pane, located at the left of the user interface by default (Section 2 annotated in FIGURE 1), 

shows layers and/or features that have been added to the project. 

VIEW PANE 

The View Pane, located at in the center of the user interface by default (Section 3 annotated in FIGURE 1), 

includes the Plan Builder, 3D View, Section View, and Report View sub‐panes. 

EDIT PANE: EDIT TAB 

The Edit Pane, located at the right of the user interface by default (Section 4 annotated in FIGURE 1), 

contains the sub‐panes of default settings for each input object including receivers, barriers, roadways, 

equipment, terrain lines, building rows, tree zones, ground zones, and contour zones. 

EDIT PANE: SEARCH AND GEOCODE TABS 

The Search and Geocode functions are located within the Edit Pane in their respective tabs after the Edit 

tab. The Edit Pane is located at the right of the user interface by default (Section 4 annotated in FIGURE 

1). 

OBJECT DETAILS PANE 

The Object Details Pane, located at the bottom of the user interface by default (Section 5 annotated in 

FIGURE 1), allows the user to review the individual attributes of each object in the open TNM project.
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Figure 1 TNM default interface layout 
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2.1 WINDOW MANIPULATION 

The size and shape of all functional areas except the Toolbar can be changed by hovering the mouse 

over the borders between each section until the directional symbol replaces the cursor, clicking, and 

dragging in the direction indicated by the symbol.  

The entire Legend Pane, as well as each tab of the Edit Pane and Object Details Pane can be minimized 

using the pin icon in the top right corner of each respective pane. Once minimized, they can be re-

accessed by hovering over the tab title. Clicking and dragging the entire Legend Pane, as well as each tab 

of the View Pane, Edit Pane, and Object Details Pane pops it out of TNM into a separate floating window 

that can be resized and/or dragged to a desired location. The floating window can be redocked in a new 

location within the TNM window by dragging it to the desired location and releasing the mouse once the 

desired TNM homepage area turns yellow, as shown in FIGURE 2. 

 
Figure 2 TNM Window Manipulation 
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3. TOOLBAR 

The Toolbar, shown in FIGURE 3, is used to perform various functions in TNM. Minimize or maximize the 

toolbar by right clicking and selecting Minimize the Ribbon. 

 
Figure 3 TNM Toolbar 

The toolbar consists of the following tabs: 

• FILE TAB 

• EDIT/MODIFY TAB 

• VIEW TAB 

• SETTINGS TAB 

• CALCULATE TAB 

• BARRIER ANALYSIS TAB 

• CONTOURS TAB 

• REPORTS TAB 

• TOOLS TAB 

• HELP TAB 

3.1 FILE TAB 

The File Tab, shown in FIGURE 4, is used for CREATING A NEW PROJECT, OPENING A PROJECT, SAVING A 

PROJECT, PRINTING A PROJECT, CLOSING A PROJECT, IMPORTING A PROJECT (or combining project files by adding 

objects from another file to the open project), and EXITING the TNM software. 

 
Figure 4 File Tab and Menu 

3.1.1 CREATING A NEW PROJECT 

To create a new project: 

1. Click the File Tab. 

2. Click New Project. The New Project dialog box appears, shown in FIGURE 5 with all possible inputs 

filled out. 
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Figure 5 New Project Dialog Box 

3. Enter the Organization for the New Project to define optional metadata.  

Note: This value may be prepopulated from the  APPLICATION SETTINGS FUNCTION. 

4. Enter the Contract for the New Project to define optional metadata.  

Note: This value may be prepopulated from the  APPLICATION SETTINGS FUNCTION. 

5. Enter the user information for the New Project in Analysis By to define optional metadata.  

Note: This value may be prepopulated from the  APPLICATION SETTINGS FUNCTION. 

6. Define the Projection Type for the New Project by selecting one of the Cartesian, Geographic, or 

Projected radio buttons. See Step 7 for more details on the three options. The Projection Type, 

Category, System, and Units Project Settings define the format for input object coordinates, as 

well as the relationship between the input objects and the basemap shown in the Plan Builder. 

7. Select the desired Category and System Projection Settings from the dropdown lists, as follows: 

• Cartesian defines spatial position using a pair of coordinates indicating that position’s 
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relationship to a fixed origin where (0,0) corresponds to the intersection of the equator 

and prime meridian on a 2‐dimensional plane of infinite distance. his system is most 

often utilized in Computer Aided Design (CAD) software and may or may not have a 

direct relationship with known coordinates on the Earth. Cartesian coordinates 

correspond to the Orthographic system used in TNM 2.5. Select ‘Cartesianʼ from the 

Category dropdown list and either ‘Cartesian 2D (Meters)ʼ or ‘Cartesian 2D (Feet)’ from 

the System dropdown list, depending on the desired units for the New Project. The 

Units value will be populated according to the System selection. 

• Geographic defines spatial position on a 3‐dimensional spherical model of the Earth. 

Coordinates are described in terms of longitude, latitude, and elevation. Latitude and 

longitude are designated using decimal degrees or in degrees, minutes, and seconds. 

The recommended Geographic Category and System selections from their respective 

dropdown lists for New Projects located in North America are Category = ‘Worldʼ and 

System = ‘WGS1984ʼ. These settings leverage the WGS84 (EPSG: 4326) in decimal 

degrees, which is a standard in cartography and navigation/global positioning systems. 

The Units value will be populated according to the System selection. 

• Projected defines spatial position on a model of the surface of the Earth where the 

Earthʼs surface is rendered as a flat, 2‐dimensional surface. Different projected systems 

preserve or alter distance, shape/areas, and North directionality, among other factors 

that should be taken into consideration when selecting a projected coordinate system. 

In the absence of project-specific projection information, the recommended Projected 

Category and System selections from their respective dropdown lists for New Projects 

located in North America are Category = ‘Worldʼ and System = ‘WebMercatorʼ. These 

settings leverage the WGS84 Web Mercator (EPSG: 3857) in meters, which is the de 

facto standard for web mapping applications. The Units value will be populated 

according to the System selection. See the FAQ document for more information. 

8. Select the roadway noise analysis metric and roadway traffic input format for the New Project 

from the Traffic dropdown list.  

Note: This value may be prepopulated from the  APPLICATION SETTINGS FUNCTION.  

Choose from: 

• LAeq1h: Volumes, Speeds 

• LAeq1h: Percent Volumes, Speeds 

• Ldn: Day Night 

• Lden: Day Evening Night 

9. Select the Roadway Report Metric for the New Project using the dropdown list.  

Note: This value may be prepopulated from the  APPLICATION SETTINGS FUNCTION. Also note, this 

dropdown will be disabled if LAeq1h is not selected from the Traffic dropdown list in step 8.  

If LAeq1h is selected, choose from the following options:  

• LA Avg (the average noise level across the hour) 

• LA10 (the noise level exceeded 10% of the hour) 

• LA50 (the noise level exceeded 50% of the hour) 

10. Select the construction noise analysis metric for the New Project using the RCNM Report Metric 

dropdown list.  

Note: This value may be prepopulated from the  APPLICATION SETTINGS FUNCTION.  
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Choose from: 

• LAeq 

• LAsmax 

11. Enter the construction noise Analysis Period value for the New Project in the RCNM Analysis 

Period field.  

Note: This value may be prepopulated from the  APPLICATION SETTINGS FUNCTION. Also note, this 

field will be disabled if LAsmax is selected from the RCNM Report Metric dropdown list in step 

10, as shown in FIGURE 5. 

12. Enter the Relative Humidity value for the New Project.  

Note: This value may be prepopulated from the  APPLICATION SETTINGS FUNCTION.  

Recommendation: maintain default values, except for extreme weather conditions. 

13. Enter the Temperature value for the New Project.  

Note: This value may be prepopulated from the  APPLICATION SETTINGS FUNCTION.  

Recommendation: maintain default values, except for extreme weather conditions. 

14. Select a Ground Type for the New Project to define the default ground material applied 

throughout the Project extent, apart from areas covered by objects with unique acoustic ground 

impedance, namely roadways, ground zones, and tree zones. See SECTIONS 6.8.2 and 9.8 for 

more details on how ground impedance is quantified.  

Note: This value may be prepopulated from the  APPLICATION SETTINGS FUNCTION.  

Choose from the following options in the dropdown list: 

• Pavement 

• Water 

• Hard Soil 

• Loose Soil 

• Lawn 

• Field Grass 

• Granular Snow 

• Powder Snow 

15. Enter the LOS Distance Limit to define the range of the line of sight checking tool for the New 

Project. 

16. Check or uncheck the “Enable state plane adjustment” checkbox to toggle the option for the 

New Project. Once enabled, the Scale and Offset radio buttons can be selected, and X/Y 

coordinates can be entered. Check or uncheck the checkbox to maintain the aspect ratio for the 

New Project coordinate system. 

17. Enter the Name of the New Project. 

18. Enter the Description of the New Project to define optional metadata. 

19. Click Create to create the New Project. 

20. Click Cancel at any time to cancel the creation of the New Project. 

3.1.2 OPENING A PROJECT 

To open an existing project: 

1. Click the File Tab. 

2. Click Open Project. A file explorer window opens.  



TNM 3.2 User’s Guide 

 

 

Page 9 of 63 

Note: This option will be disabled if a project is currently open. Click Close Project in the File Tab 

to enable project opening. 

3. Navigate to the desired file. 

4. Select your project and click the Open button in the file explorer to open the project in TNM. 

5. Click Cancel in the file explorer at any time to cancel opening a project. 

3.1.3 SAVING A PROJECT 

To save a project or save a project as: 

1. Click the File Tab. 

2. Click Save Project. A window stating ‘Project Saved’ will appear when complete.  

Note: This option will be disabled if no project is currently open. 

3. Click OK. 

4. Click Save Project As. A file explorer window opens. 

5. Enter a Project Name in the file explorer and click Save. A window stating ‘Project Saved’ will 

appear when complete. Click OK. 

6. Click Cancel in the file explorer at any time to cancel saving a project. 

3.1.4 PRINTING A PROJECT 

To print a project: 

1. Click the File Tab. 

2. Click Print Project. A window opens containing printing options.  

3. Select the desired printing options in the window and click Print when done.  

4. Click Cancel in the Print window at any time to cancel printing the project. 

3.1.5 CLOSING A PROJECT 

To close a project: 

1. Click the File Tab. 

2. Click Close Project. The project data will disappear from all function panes, but the TNM 

application will remain open. 

3.1.6 IMPORTING A PROJECT 

To import a project (or combine project files by adding objects from another file to the open project): 

1. Click the File Tab. 

2. Click Import From XML. A file explorer window opens. 

3. Navigate to the desired file. 

4. Select your project in the file explorer and click the Open button to import the project. 

5. Click Cancel in the file explorer at any time to cancel importing a project. 

3.1.7 EXITING 

To exit the TNM software: 

1. Click the File Tab. 

2. Click Exit. The TNM application will close.  
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Note: If a project is currently open when Exit is clicked, a window will display prompting a save of 

the current project. After responding to that window, the TNM application will close. 

3.2 EDIT/MODIFY TAB 

The Edit/Modify tab contains the SHARED TOOLS FUNCTION, the GENERAL SELECT FUNCTION, and the RECEIVERS, 

BARRIERS, ROADWAYS, EQUIPMENT, TERRAIN LINES, BUILDING ROWS, TREE ZONES, GROUND ZONES,  OR CONTOUR 

ZONES SELECT FUNCTION. When editing an object, it must first be selected. An object can be selected by 

clicking on it in the PLAN BUILDER or OBJECT DETAILS PANE or by using the Edit/Modify tab to easily access 

multiple object selection options. 

3.2.1 SHARED TOOLS FUNCTION 

The Shared Tools Function, shown in FIGURE 6, includes Delete, Edit, and Segments buttons to modify 

selected objects. The Enable Object Add button toggles whether the mouse is used in the Plan Builder 

for editing existing objects or creating new objects. 

 
Figure 6 Shared Tools Function 

To delete an entire object that has been selected, click the Delete button. 

Click the Edit button to enable graphical movement of entire objects or individual object points in the 

Plan Builder. See the EDIT PANE: EDIT TAB for more information on editing an object’s attributes. 

The Segments button contains a dropdown list of actions (shown in FIGURE 7) to apply to the selected 

feature(s). This button will be disabled, as shown in FIGURE 6, if no segmented objects are currently 

selected. 

 
Figure 7 Segments button and sub-menu 

• Enter a Divide (Length) to divide a feature by length. 

• Enter a Divide (Number) to divide a feature by a numerical amount (e.g., divide into 4 sections). 

• Click Combine Two Objects to combine selected objects on the map.1 

• Click Divide Object in Two to split to an object into two separate objects. 

 
1 Note that if users are attempting to combine equipment objects, only non-stationary equipment objects of the same 

equipment ID can be combined. Once combined, users will need to re-enter the ‘Time Active’ input for the new object.  
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Verify that object attributes (e.g., traffic, flow control, structural pairings, etc.) are correct for all 

segments after applying one of the actions within the Segments button.  

The Shared Tools function also includes the Enable Object Add button that allows or disallows drawing 

of objects in the Plan Builder. This button can be toggled via mouse click or the “D” key on the keyboard. 

TNM can only perform either the Edit or the Enable Object Add functions at a time, such that toggling 

the Enable Object Add function on will automatically disable the Edit function and vice versa. 

3.2.2 GENERAL SELECT FUNCTION 

To graphically move or delete objects, they must first be selected. See the EDIT PANE: EDIT TAB for more 

information on editing an object’s attributes. 

1. To select objects of multiple types at once in the Plan Builder, click the General Select button, 

shown in FIGURE 8. 

2. Choose Inside or Outside from the dropdown menu to define the rules for the desired area of 

selection. 

3. If Inside is chosen, highlight the desired objects by clicking and dragging in the Plan Builder to 

draw a rectangular area of selection over the objects of interest. Upon release of the mouse, all 

objects contained within the area of selection will be highlighted to indicate their selection. 

4. If Outside is chosen, highlight the desired objects by clicking and dragging in the Plan Builder to 

draw a rectangular area of selection that does not include any of the desired objects. Upon 

release of the mouse, all objects NOT contained within the area of selection will be highlighted 

to indicate their selection. 

Note: Objects and/or segments can also be selected by single click in the PLAN BUILDER or OBJECT DETAILS 

PANE. Multiple objects can be selected at once by holding the ‘Ctrl’ key while clicking. 

 
Figure 8 General Select Function 

3.2.3 RECEIVERS, BARRIERS, ROADWAYS, EQUIPMENT, TERRAIN LINES, 

BUILDING ROWS, TREE ZONES, GROUND ZONES,  OR CONTOUR ZONES 

SELECT FUNCTION 

To graphically move or delete receivers, barriers, roadways, equipment, terrain lines, building rows, tree 

zones, ground zones,  or contour zones, they must first be selected. See the EDIT PANE: EDIT TAB for more 

information on editing an object’s attributes. 

1. To select objects of a particular type, click the Selection button for that object type. All options 

are shown in FIGURE 9.  

2. Choose Select, Select All, or Deselect All from the dropdown menu to highlight the desired 

objects. 

3. If Select is chosen, highlight the desired objects by clicking and dragging in the Plan Builder to 

draw a rectangular area of selection over the objects of interest. Upon release of the mouse, all 

objects of the respective object type contained within the area of selection will be highlighted to 

indicate their selection. 
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Figure 9 Available Object Select buttons with Icons 

3.3 VIEW TAB 

The View tab, shown in FIGURE 10, contains the SYNC 3D GEOMETRY FUNCTION, SYNC 3D VIEW FUNCTION, 

EXAGGERATE HEIGHTS FUNCTION, ZOOM EXTENT FUNCTION, START SECTION FUNCTION, TOGGLE POINT LABELS 

FUNCTION, and TOGGLE OBJECT LABELS FUNCTION. 

 
Figure 10 View Tab 

3.3.1 SYNC 3D GEOMETRY FUNCTION 

To sync the 3D geometry with the Plan Builder: 

1. Click the Sync 3D Geometry button. 

2. The Plan Builder and 3D View will refresh and display identical data in their respective formats. 

3.3.2 SYNC 3D VIEW FUNCTION 

To sync the 3D View with the Plan Builder: 

1. Click the Sync 3D View button. 

2. The 3D View will refresh to match the view extent of the Plan Builder. 

3.3.3 EXAGGERATE HEIGHTS FUNCTION  

To exaggerate the height of objects in the 3D View: 

1. Click the Exaggerate Heights button. 

2. Objects that have height above the ground will appear farther off the ground in the 3D View. 

3.3.4 ZOOM EXTENT FUNCTION 

To see all objects in the Plan Builder and 3D View: 

1. Click the Zoom Extent button 

2. The Plan Builder and 3D View will refresh to include all input objects in their extent. 

3.3.5 START SECTION FUNCTION 

The Start Section Function replaces the Skew View from TNM 2.5. It allows drawing of a section line in 

the Plan Builder to open the Section View containing a cross section of the input objects that intersect 

the section line. 

To draw a section line: 

1. Click the Start Section button. 

2. Click in the Plan Builder to begin drawing the section line. A blue line will appear as drawing of 
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the section line continues. 

3. Double click to terminate the section line in the Plan Builder such that the line crosses through 

all objects desired to be seen in the Section View. 

4. The View Pane will switch from the Plan Builder to the Section View, which will display a cross 

section of the input objects included in the section line. 

5. The Legend Pane will now include a ‘SectionLine’ item that can be toggled on and off in the Plan 

Builder. Section lines appear in the Plan Builder as dotted blue lines.  

3.3.6 TOGGLE POINT LABELS FUNCTION 

• To toggle object name labels for a specific object type, check or uncheck the checkbox next to 

the name of the desired object type.  

• To toggle object name labels for all objects, click the Toggle All Object Labels Button. 

3.3.7 TOGGLE OBJECT LABELS FUNCTION 

• To toggle point name labels for a specific object type, check or uncheck the checkbox next to the 

name of the desired object type.  

• To toggle point name labels for all objects, click the Toggle All Point Labels Button. 

3.4 SETTINGS TAB 

The Settings Tab, shown in FIGURE 11, contains the APPLICATION SETTINGS FUNCTION and PROJECT SETTINGS 

FUNCTION. 

 
Figure 11 Settings Tab 

3.4.1 APPLICATION SETTINGS FUNCTION 

Prior to creating a new project, specific input settings can be tailored by preferences. These settings will 

apply to all new projects by appearing in the New Project dialog box (FIGURE 5) when CREATING A NEW 

PROJECT.  

The Application Settings function is enabled when there is no open project in TNM. To adjust the 

Application Settings, click the Application Settings button. The Application Settings dialog box appears, 

shown in FIGURE 12 with all possible inputs filled out. 
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Figure 12 Application Settings Dialog Box 

1. Enter a default Organization Name to define optional metadata. 

2. Enter a default Contract Name to define optional metadata. 

3. Enter default user information in Analysis By to define optional metadata. 

4. Select a default Unit of Measure from the dropdown list. Choose English or Metric. 

5. Select a default roadway noise analysis metric and roadway traffic input format from the Traffic 

dropdown list. Choose from: 

• LAeq1h: Volumes, Speeds 

• LAeq1h: Percent Volumes, Speeds 

• Ldn: Day Night 

• Lden: Day Evening Night 

6. Select the default Report Metric using the dropdown list.  

Note: This dropdown will be disabled if LAeq1h is not selected from the Traffic dropdown list in 

step 5.  

If LAeq1h is selected, choose from the following options: 

• LA Avg (the average noise level across the hour) 

• LA10 (the noise level exceeded 10% of the hour) 

• LA50 (the noise level exceeded 50% of the hour) 

7. Select the default construction noise analysis metric using the RCNM Report Metric dropdown 

list. Choose from: 

• LAeq 

• LAsmax 

8. Enter the default construction noise Analysis Period value in the RCNM Analysis Period field.  

Note: This field will be disabled if LAsmax is selected from the RCNM Report Metric dropdown list 
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in step 7. 

9. Enter a default Relative Humidity value. 

10. Enter a default Temperature value. 

11. Select a default Ground Type to define the ground material applied throughout the project 

extent, apart from areas covered by objects with unique acoustic ground impedance, namely 

roadways, ground zones, and tree zones. See SECTIONS 6.8.2 and 9.8 for more details on how 

ground impedance is quantified. Choose from the following options in the dropdown list: 

• Pavement 

• Water 

• Hard Soil 

• Loose Soil  

• Lawn 

• Field Grass 

• Granular Snow 

• Powder Snow 

12. Click Save Settings to save the Application Settings. 

13. Click Cancel to abandon the changes. 

3.4.2 PROJECT SETTINGS FUNCTION 

The Project Settings function is enabled when there is an open project in TNM. Some Settings for the 

open project can be changed using this function, and all other Settings can be viewed. Saving any 

changes to the Project Settings will reset any saved results within the project. 

To view or adjust the Project Settings, click the Project Settings button. The Project Settings dialog box 

appears, shown in FIGURE 13 with all possible inputs filled out. 
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Figure 13 Project Settings Dialog Box 

1. Enter or change the Organization Name for the open Project to define optional metadata. 

2. Enter or change the Contract for the open Project to define optional metadata. 

3. Enter or change the user information for the open Project in the Analysis By field to define 

optional metadata. 

4. The Projection Type, Category, System, and Units settings are disabled as they cannot be 

changed once a project is created. This is known in FIGURE 13. 

5. Change the roadway noise analysis metric and roadway traffic input format for the open Project 
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from the Traffic dropdown list.  

Note: Changing the Traffic will reset any saved roadway or construction noise results in the open 

project.  

Choose from: 

• LAeq1h: Volumes, Speeds 

• LAeq1h: Percent Volumes, Speeds 

• Ldn: Day Night 

• Lden: Day Evening Night 

6. Change the Roadway Report Metric for the open Project using the dropdown list.  

Note: Changing the Roadway Report Metric will reset any saved roadway or construction noise 

results in the open project. Also note: this dropdown will be disabled if LAeq1h is not selected 

from the Traffic dropdown list in step 5.  

If LAeq1h is selected, choose from the following options: 

• LA Avg (the average noise level across the hour) 

• LA10 (the noise level exceeded 10% of the hour) 

• LA50 (the noise level exceeded 50% of the hour) 

7. Change the construction noise analysis metric for the open project using the RCNM Report 

Metric dropdown list.  

Note: Changing the RCNM Report Metric will reset any saved roadway or construction noise 

results in the open project.  

Choose from:  

• LAeq 

• LAsmax 

8. Change the construction noise Analysis Period value for the open project in the RCNM Analysis 

Period field.  

Note: Changing the RCNM Analysis Period will reset any saved roadway or construction noise 

results in the open project. Also note, this field will be disabled if LAsmax is selected from the 

RCNM Report Metric dropdown list in step 7. 

9. Change the Relative Humidity value for the open Project.  

Note: Changing the Relative Humidity will reset any saved roadway or construction noise results 

in the open project. 

10. Change the Temperature value for the open Project.  

Note: Changing the Temperature will reset any saved roadway or construction noise results in 

the open project. 

11. Chang the Ground Type for the open Project to define the default ground material applied 

throughout the Project extent, apart from areas covered by objects with unique acoustic ground 

impedance, namely roadways, ground zones, and tree zones. See SECTIONS 6.8.2 and 9.8 for 

more details on how ground impedance is quantified.  

Note: Changing the Ground Type will reset any saved roadway or construction noise results in 

the open project.  

Choose from the following options in the dropdown list:  

• Pavement 

• Water 

• Hard Soil 
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• Loose Soil 

• Lawn 

• Field Grass 

• Granular Snow 

• Powder Snow 

12. Change the LOS Distance Limit to define the range of the line of sight checking tool for the open 

Project. 

13. Check or uncheck the “Enable state plane adjustment” checkbox to toggle the option for the 

open Project. Once enabled, the Scale and Offset radio buttons can be selected, and X/Y 

coordinates can be entered. Check or uncheck the checkbox to maintain the aspect ratio for the 

Project coordinate system.  

Note: Changing the state plane adjustment will reset any saved roadway or construction noise 

results in the open project. 

14. Change the Name of the open Project. 

15. Enter or change the Description of the open Project to define optional metadata. 

16. Click Save Settings to save any changes to the Project Settings. 

17. Click Cancel to abandon any changes. 

3.5 CALCULATE TAB 

The Calculate tab, shown in FIGURE 14, contains the RECEIVERS FUNCTION, FOR ROADWAYS FUNCTION, FOR 

EQUIPMENT FUNCTION, and PARALLEL BARRIER (CALCULATE SECTION) FUNCTION. 

After setting up a project and adding all the needed input objects to the Plan Builder, users can calculate 

the noise level of roadway traffic or roadway construction activity at receivers that have been 

strategically placed in the area of interest. The results of these calculations are used to assist in the 

design of noise barriers. 

 
Figure 14 Calculate Tab 

3.5.1 RECEIVERS FUNCTION 

The Receivers Function contains the Set Active button. The Set Active options allows toggling of the 

activation of receivers to be used for the calculate functions. 

3.5.2 FOR ROADWAYS FUNCTION 

The For Roadways Function contains All Receivers and Active Receivers buttons.  

Note: Performing one of the following steps is required in order to enable the BARRIER ANALYSIS TAB. 

• To calculate all active and inactive receivers for roadway noise using a single thread, click the 

top half of the All Receivers button. Open the dropdown menu and select “All Roadways in 

parallel (beta)” to enable multi-threaded computation for roadway noise. A Calculation window 

appears displaying the computation progress. Users will be prompted to click OK when the 
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calculation is complete. The spectral data file called thirdoct_roadways_<Roadway Noise 

Metric>.csv (where the Roadway Noise Metric is established via the Traffic input in the Project 

Settings dialog box, see FIGURE 13) will automatically be saved in the following directory: 

Documents\TNM\Temp\<Project Name>. The ROADWAY RESULTS DETAIL SUB-PANE of the OBJECT 

DETAILS PANE opens. 

• To calculate only the active receivers for roadway noise using a single thread, click the top half 

of the Active Receivers button. Open the dropdown menu and select “Active Receivers in 

parallel (beta)” to enable multi-threaded computation for roadway noise. A Calculation window 

appears displaying the computation progress. Users will be prompted to click OK when the 

calculation is complete. The spectral data file called thirdoct_roadways_<Roadway Noise 

Metric>.csv (where the Roadway Noise Metric is established via the Traffic input in the Project 

Settings dialog box, see FIGURE 13) will automatically be saved in the following directory: 

Documents\TNM\Temp\<Project Name>. The ROADWAY RESULTS DETAIL SUB-PANE of the OBJECT 

DETAILS PANE opens. 

• To identify non-permitted input data for roadway noise analyses, click the Check Inputs button.  

Note: Parallel processing is currently a beta feature in TNM 3.2 to reduce computation time in early 

modeling stages. It should not be used to compute final noise levels reported for regulatory analyses. 

3.5.3 FOR EQUIPMENT FUNCTION 

The For Equipment Function contains All Receivers and Active Receivers buttons. 

• To calculate all active and inactive receivers for equipment noise using a single thread, click the 

All Receivers button. A Calculation window appears displaying the computation progress. Users 

will be prompted to click OK when the calculation is complete. The spectral data file called 

thirdoct_equipment_<RCNM Report Metric>_<Analysis Period>hr.csv (where the RCNM Report 

Metric and Analysis Period are established via the Project Settings dialog box, see FIGURE 13) will 

automatically be saved in the following directory: Documents\TNM\Temp\<Project Name>. The 

EQUIPMENT RESULTS DETAIL SUB-PANE of the OBJECT DETAILS PANE opens. 

• To calculate only the active receivers for equipment noise using a single thread, click the top half 

of the Active Receivers button. Open the dropdown menu and select “Active Receivers in 

parallel (beta)” to enable multi-threaded computation for equipment noise. A Calculation 

window appears displaying the computation progress. Users will be prompted to click OK when 

the calculation is complete. The spectral data file called thirdoct_equipment_<RCNM Report 

Metric>_<Analysis Period>hr.csv (where the RCNM Report Metric and Analysis Period are 

established via the Project Settings dialog box, see FIGURE 13) will automatically be saved in the 

following directory: Documents\TNM\Temp\<Project Name>. The EQUIPMENT RESULTS DETAIL SUB-

PANE of the OBJECT DETAILS PANE opens. 

• To identify non-permitted input data for construction noise analyses, click the Check Inputs 

button.  

Note: Parallel processing is currently a beta feature in TNM 3.2 to reduce computation time in early 

modeling stages. 

3.5.4 PARALLEL BARRIER (CALCULATE SECTION) FUNCTION 

The Parallel Barrier Function allows the user to define a section line between two parallel barriers and 
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calculate the degradation of barrier performance as the sound waves from the noise sources bounce 

between the barriers. 

To compute the noise level increase due to parallel barriers: 

1. Click the Calculate Section button. 

2. Click in the Plan Builder to begin drawing a line through at least one receiver, at least one 

roadway or equipment source, and the parallel barriers. A red line will appear as drawing 

continues. 

3. Double click to terminate the line, drawn as perpendicular as possible to the parallel barriers. 

4. The Roadway or Equipment Results tab will open in the OBJECT DETAILS PANE based on which 

source type was included in the section line. The respective tab will display the noise level 

increase due to the parallel barriers in the Parallel Increase column.  

Note: The computed barrier performance degradation should be applied to the pertinent receiver(s) 

outside of TNM because the parallel barrier analysis only accounts for the given barrier heights. Thus, the 

results only pertain to that barrier design (i.e., not the “No Barrier” levels or noise levels for any other 

barrier design), whereas the Adjustment Factors in TNM 3.2 (See SECTION 8.3) apply to all computed 

results throughout the model regardless of barrier segment height. 

3.6 BARRIER ANALYSIS TAB 

The Barrier Analysis tab is used when determining the optimal heights for each barrier segment when 

barrier perturbations have been included in the calculations. The Barrier Analysis tab contains the MODE 

FUNCTION, 

CURRENT ANALYSIS FUNCTION, and EXISTING ANALYSIS FUNCTION. The Barrier Analysis Tab tools will be 

disabled, as shown in FIGURE 15, until the project includes a completed roadway noise receiver 

calculation using the FOR ROADWAYS FUNCTION. The MODE FUNCTION and EXISTING ANALYSIS FUNCTION can 

then be used to analyze the results from that calculation. 

 
Figure 15 Barrier Analysis Tab 

3.6.1 MODE FUNCTION 

The Mode Function contains the Start Analysis button.  

To begin analyzing the For Noise Abatement barriers in the open project: 

1. Click the Start Analysis button. The TNM workspace layout will shift to the Barrier Analysis 

Module, as shown in FIGURE 16. The Start Analysis button in the Mode Function will be replaced 

with the End Analysis button. The Load button in the EXISTING ANALYSIS FUNCTION will become 

disabled. All TOOLBAR functions within the EDIT/MODIFY TAB, SETTINGS TAB, CALCULATE TAB, 

CONTOURS TAB, and REPORTS TAB will become disabled or non-functional.  

Note: Only the active receivers and For Noise Abatement barriers will be shown in the Barrier 
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Analysis Module workspace elements.  

The Barrier Analysis Module workspace elements on the top include a Plan Builder, 3D View, 

and the Barrier Analysis Tool pane.  

Note: The objects in the Barrier Analysis Module Plan Builder cannot be edited, but the view in 

the Barrier Analysis Module Plan Builder and 3D View can be tailored using the same controls 

enumerated in SECTIONS 3.3, 5.1, and 5.2.  

The Barrier Analysis Tool pane includes a dropdown list of all For Noise Abatement barriers. The 

Barrier Analysis Module workspace elements on the bottom include the Receivers (Active) Table 

and two Barrier Design Tables that can be selected with tabs at the bottom right of the 

application. The data in these tables can be exported to .csv files at any time by clicking the 

Excel symbol in the bottom right corner of the desired table. A file explorer opens to designate 

the output file name and directory.  

Note: Once saved, these files will not update to reflect any future changes made in the Barrier 

Analysis Module.  

2. Select a Barrier using the dropdown list in the Barrier Analysis Tool Pane. Each segment of the 

selected barrier will be displayed along with the current heights.  

3. Click the Up and Down buttons to perturb the corresponding barrier segment. Perturbing the 

barrier using these controls will update the barrier segment height in the 3D view and the 

resulting data in all three tables will reflect the newly established barrier design.  

4. Click the Perturb Barrier Up and Perturb Barrier Down buttons in the bottom of the Barrier 

Analysis Tool Pane to perturb all segments at once for the selected barrier. Perturbing the 

barrier using these controls will update the barrier segment height in the 3D view and the 

resulting data in all three tables will reflect the newly established barrier design.  

5. When all barrier segment height perturbations have been selected for all Noise Abatement 

barriers in order to achieve the desired results in the Barrier Analysis tables, click the End 

Analysis button in the Mode Function of the Barrier Analysis toolbar. A window appears 

prompting a save of the current project. Simultaneously, the TNM interface layout will revert to 

the configuration as it was before clicking the Start Analysis button. 

See the TNM 3.2 FAQs (FHWA-HEP-24-013) for more information. 

https://www.fhwa.dot.gov/environment/noise/traffic_noise_model/tnm_v32/
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Figure 16 Barrier Analysis Module Layout 

3.6.2 CURRENT ANALYSIS FUNCTION 

The Current Analysis Function contains the Save and LOS Check buttons. These buttons are enabled 

when in the Start Analysis mode (i.e., a barrier design is open - see SECTION 3.6.1). 

To save the current barrier design: 

1. Click the Save button. The Save Current Analysis dialog box appears. The default barrier designs 

of All Barriers at Zero Height, All Abatement Barrier Segments at Zero Height, and Input Heights 

are displayed in the list of Other Saved Analyses, as shown in FIGURE 17.  

2. Enter a name for the current barrier design in the New Name field. 

3. Click Save in the Save Current Analysis dialog box. A window stating ‘Project Saved’ will appear 

when complete. Click OK in the Project Saved window. 

4. Click Cancel in the Save Current Analysis dialog box at any time to abandon saving the current 

barrier design. 

 
Figure 17 Save Current Barrier Analysis Dialog Box 
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The LOS Check function enables the user to determine the degree to which selected barrier segments in 

the current barrier design break the line of sight between selected receivers and all roadways.  

To check line of sight: 

1. Select at least one receiver and one barrier segment for the tool to evaluate by holding the ‘Ctrl’ 

key while clicking in the Plan Builder. 

2. Click the LOS Check button. Graphic lines in the 3D View connecting the chosen receivers with 

all roadway segments appear for all selected barrier segments, as shown in FIGURE 18. Green 

graphic rays indicate complete line of sight blockage for all vehicle sources. Yellow graphic rays 

indicate a line-of-sight blockage for some vehicle sources, while red graphic rays indicate a 

direct line of sight from source to receiver (i.e., no blockage of any vehicle source).  

3. Perturb the selected barrier segments using the Barrier Analysis Tool pane. The graphic ray 

colors will update to reflect the current barrier design heights.  

4. Click the LOS Check button to clear the graphic rays from the 3D View. 

 
Figure 18 Barrier Analysis Module Line of Sight Check 

3.6.3 EXISTING ANALYSIS FUNCTION 

The Existing Analysis function contains the Load button. This button will be disabled if in Start Analysis 

mode (i.e., a barrier design is open - see SECTION 3.6.1). 

To open an existing barrier design: 

1. Click the Load button in the Existing Analysis Function. The Load Barrier Analysis dialog box 

appears, as shown in FIGURE 19. 

2. Click the Load button in the Open Analysis column of the Load Barrier Analysis dialog box.  

3. Click the Close button at any time to cancel opening an existing barrier design. 

To delete an existing barrier design: 

1. Click the Load button in the Existing Analysis Function. The Load Barrier Analysis dialog box 
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appears, as shown in FIGURE 19. 

2. Click the Delete button in the Delete Analysis column of the Load Barrier Analysis dialog box. A 

window appears prompting confirmation of the decision to delete the existing barrier design.  

3. Click Yes. A window stating ‘Project Saved’ will appear when complete. 

4. Click the Close button in the Load Barrier Analysis dialog box when finished. 

 
Figure 19 Load Barrier Analysis Dialog Box 

 

3.7 CONTOURS TAB 

The Contours tab, shown in FIGURE 20, is used when conducting a calculation for a selected contour 

zone. The Contours tab contains the CONTOUR LEVELS FUNCTION, CALCULATE CONTOUR FUNCTION, and the 

GRID FILE FUNCTION. See the TNM 3.2 FAQS (FHWA-HEP-24-013) for information not found below. 

  
Figure 20 Contours Tab 

3.7.1 CONTOUR LEVELS FUNCTION 

The Contour Levels Function allows the user to establish the noise level range and step size between 

grid cells for contour zone calculations.  

To establish the contour parameters for future calculations: 

1. Click the Contour Levels button. The Contour Levels dialog box appears, as shown in FIGURE 21. 

2. Enter the range minimum, maximum, and step inside range values for the desired contour type. 

3. Click OK to save the input values. 

4. Click Cancel to abandon the input values. 

https://www.fhwa.dot.gov/environment/noise/traffic_noise_model/tnm_v32/
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Figure 21 Contour Levels Dialog Box 

3.7.2 CALCULATE CONTOUR FUNCTION 

The Calculate Contour Function contains the Sound Level, Noise Reduction, Level Difference, and Clear 

Contour buttons.  

To conduct a contour calculation: 

1. Select a single contour. 

2. Click the Sound Level, Noise Reduction, or Level Difference buttons to initiate the desired 

contour type. A dialog box appears according to the selected contour type, shown in FIGURE 22, 

FIGURE 23, and FIGURE 24. All saved barrier designs, including the three default options, are 

shown. 

3. Select the desired barrier design to apply to the contour calculation. 

4. Click OK to initiate calculation. The ROADWAY RESULTS DETAIL SUB-PANE of the OBJECT DETAILS PANE 

opens. A Calculation window appears displaying the computation progress. Users will be 

prompted to click OK when the calculation is complete. 

5. The computed contour grid will appear on the Plan Builder. The contour grid file will 

automatically be saved will automatically be saved in the following directory: 

Documents\TNM\Temp\<Project Name>. The file name is auto-generated with the following 

three components separated by an underscore: two-letter code for contour type (i.e., SL = 

Sound Level, NR = Noise Reduction, and LD = Level Difference), TNM contour object name, and 

name of the barrier design selected by the user when prompting a contour calculation. See 

Table 12 in the TNM 3.2 Technical Manual (FHWA-HEP-24-015) for details on the file format. 

To remove a displayed contour: 

1. Select the desired contour for removal. 

2. Click the Clear Contour dropdown menu. 

3. Click the Clear Selected Contour option in the dropdown menu. 

https://www.fhwa.dot.gov/environment/noise/traffic_noise_model/tnm_v32/
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Figure 22 Sound Level Contour Dialog Box 

 
Figure 23 Noise Reduction Contour Dialog Box 

 
Figure 24 Level Difference Contour Dialog Box 
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3.7.3 GRID FILE FUNCTION 

The Grid File Function contains the Load Grid File and Delete Grid File buttons.  

To redisplay a previously computed contour2 in future TNM sessions: 

1. Click the Load Grid File button. A file explorer window opens.  

2. Navigate to the desired grid file. 

3. Select the grid file and click the Open button in the file explorer to open the contour in TNM. 

4. Click Cancel in the file explorer at any time to cancel loading a grid file. 

To delete a grid file: 

1. Click the Delete Grid File button. A file explorer window opens.  

2. Navigate to the desired grid file. 

3. Select the grid file and click the Open button in the file explorer to delete the grid file. 

4. Click Cancel in the file explorer at any time to cancel deleting a grid file. 

3.8 REPORTS TAB 

The Reports Tab contains the INPUT REPORTS FUNCTION and RESULTS REPORTS FUNCTION. Each Reports 

function contains links to reports that are visible in the REPORT VIEW. 

3.8.1 INPUT REPORTS FUNCTION 

The Input Reports Function contains links to the Input Reports. Click any report link to view the report in 

the REPORT VIEW.  

The following Input Reports are listed: 

• Receivers 

• Barriers  

• Tree Zones 

• Traffic for TNM Vehicles 

• Receiver Adjustment Factors 

• On‐Structure Barriers 

• Contour Zones 

• Traffic for User Defined Vehicles 

• Terrain Lines 

• Reflecting Barriers 

• Roadways 

• Building Rows 

• Ground Zones 

• Equipment 

 

 
2 Note that the loaded grid file will reflect the Contour Levels settings saved at the time of computation and will not 

be impacted by the current Contour Levels settings.  
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3.8.2 RESULTS REPORTS FUNCTION 

The Result Reports Function contains links to the Result Reports. Click any report link to view the report 

in the REPORT VIEW.  

The following Result Reports are listed: 

• Sound Levels ‐ No Barrier Objects 

• Sound Levels Diagnosis by Road Segment 

• Sound Levels ‐ Input Heights 

• Sound Levels Diagnosis By Barrier Segment 

• Barrier Descriptions 

• Sound Levels Diagnosis by Vehicle Type ‐ Input Heights 

• Barrier ‐ Segment Descriptions 

3.9 TOOLS TAB 

The Tools tab, shown in FIGURE 25, contains the NAVIGATION HISTORY FUNCTION and MEASURE FUNCTION.  

 
Figure 25 Tools Tab 

3.9.1 NAVIGATION HISTORY FUNCTION 

Navigation allows users to revert to recent map locations in the VIEW PANE. 

• To revert to a prior map location, click the Previous button.  

• To advance to the next prior map location, click the Next button. 

3.9.2 MEASURE FUNCTION 

The Measure Function allows distances to be approximated in the Plan Builder using the default unit of 

measure for the project. To approximate a distance: 

1. Click the Measure Distance button. 

2. Click in the Plan Builder to begin drawing at the desired location. A red line with a tooltip 

displaying the segment distance will display as drawing of the measurement line continues. 

3. Click as many vertices as desired to measure the total distance. 

4. Double click the end point location of the measurement line. The total distance of the 

measurement line will display on the Plan Builder. 

5. To remove every measurement line on the Plan Builder, click the Remove All Measures button. 
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3.10 HELP TAB 

The Help Tab, shown in FIGURE 26, contains the Getting Started, Help and About buttons.  

• To open a PDF of the Getting Started Guide, click the Getting Started button. 

• To open a PDF of the User’s Guide (i.e., this document), click the Help button. 

• To view version information for TNM, click the About button. 

 
Figure 26 Help Tab 
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4. LEGEND PANE 

The Legend Pane displays the layers and/or features that have been added to the project, such as a 

roadway or Section Line, the object type will be listed in the Legend Pane. Once a feature is listed in the 

Legend Pane, users can choose whether the object type is visible in the Plan Builder and users can adjust 

the transparency of the object type in the Plan Builder. 

• To toggle feature visibility in the Plan Builder, check or uncheck the checkbox next to the feature 

type in the Legend Pane. 

• To adjust the transparency in the Plan Builder, move the slider along the bar next to the feature 

type in the Legend Pane. 
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5. VIEW PANE 

The View Pane displays the map and associated map data using different visualization methods, shown 

in FIGURE 27. The View Pane contains the following four sub‐panes: PLAN BUILDER, 3D VIEW, SECTION VIEW, 

and REPORT VIEW. 

 
Figure 27 View Pane Tabs 

 

5.1 PLAN BUILDER 

The Plan Builder sub‐pane displays the map in a top‐down 2D format, as shown in FIGURE 28. The 

majority of input object creation is conducted in the Plan Builder. Object edits or selections made using 

the OBJECT DETAILS PANE will be reflected in the Plan Builder. See also: DRAWING IN THE PLAN BUILDER. 

To interact with the map in the Plan Builder: 

• Click and drag the mouse to pan the map. 

• Scroll the mouse wheel to zoom. 

• Right click to open a list of the following functions: 

o Zoom to Best View 

o Clear Selection 

o Select All 

o Select All of Type: Receiver, Barrier, Roadway, Equipment, Terrain Line, Building Row, 

Tree Zone, Ground Zone, or Contour Zone 

• Click the Eye icon at the bottom of the View Pane to open the following list of basemap options: 

o Aerial View 

o Physical View 

o Shaded Relief View 

o Road View (Note: this is the default) 

o Terrain Base View 

o Topographical View 

• Click the arrow in the upper right corner of the Plan Builder to view a zoomed out version of the 

map showing the extent of the input objects in a wider geographical context. 

• Toggle the visibility and transparency of features in the Plan Builder using the LEGEND PANE 

• Select objects via manual click or the features within the Toolbar EDIT/MODIFY TAB 

• Graphically edit the location of input objects using the Edit button in the SHARED TOOLS FUNCTION 

• Add new objects using the Enable Object Add button in the SHARED TOOLS FUNCTION 

• Modify the view using the Basic Tools and label toggles in the Toolbar VIEW TAB 
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Figure 28 Plan Builder 

 

5.2 3D VIEW 

The 3D View sub‐pane displays the map and all input objects in a three‐dimensional format, as shown in 

FIGURE 29. The 3D view is a three‐ dimensional representation of the 2D view in the Plan Builder such 

that the default perspective is top-down. Manipulating the 3D view perspective using the technique in 

the third bullet below allows users to see object elevation above the flat basemap. 

To interact with the map in the 3D view: 

• Click and drag the mouse to pan the map. 

• Scroll the mouse wheel to zoom. 

• Hold the middle mouse wheel and drag the mouse to rotate the map on an axis. 

• Use the 3D Settings functions in the Toolbar VIEW TAB to manipulate the 3D View. 

 
Figure 29 3D View 
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5.3 SECTION VIEW 

The Section View sub-pane is used to visualize distance between selected objects, selected object 

heights, and elevation changes, as shown in FIGURE 30. The Section View displays a cross section of the 

input objects where a section line has been drawn in the Plan Builder using the START SECTION FUNCTION. 

When switching between tabs in the VIEW PANE, the Section View will always display the objects from 

the most recently drawn section line. 

To interact with the Section View: 

• Scroll the mouse wheel to zoom both axes at once. 

• To zoom one axis independently, hover the mouse over the scroll bar for the axis of interest 

until the directional symbol replaces the cursor, click, and drag in the direction indicated by the 

symbol.  

• Click the Reset Zoom button to restore the Section View to the default dimensions. 

• Click the Toggle Labels button to enable/disable the object names displayed in the Section View. 

• Click the Save View button to capture a .png of the current view including zoom and label 

settings. A file explorer window opens. 

 
Figure 30 Section View 

5.4 REPORT VIEW 

The Report View sub‐pane is used to display and export selected reports for the open project. An 

excerpt of the Report View is shown in FIGURE 31. Reports are selected using the Toolbar REPORTS TAB. 

When switching between tabs in the VIEW PANE, the Report View will always display the data from the 

most recently selected report. Some of the header information above the data tables for each report is 

generated from the metadata inputs in the PROJECT SETTINGS FUNCTION. 

To interact with the Report View: 

• Use the arrows or text box in the top left corner as well as the mouse scroll wheel to navigate 

through multiple pages. 
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• Click the Refresh icon to update a stale report.  

• Click the Page Setup icon. A window opens containing layout settings.  

• Click the Print Layout icon. The Report View will refresh to reflect the selected layout settings. 

• Once satisfied with the layout, click the Print icon. A window opens containing print settings. 

• Click the export icon. A dropdown list opens with the following output format options: 

o Excel 

o PDF 

o Word 

• Select the desired report output format. A file explorer opens to designate the output file name 

and directory.  

• Use the dropdown menu to adjust the report zoom. 

 
Figure 31 Report View 
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6. EDIT PANE: EDIT TAB 

The Edit Tab within the Edit Pane contains the functions for editing TNM object default values. The 

following default editing functions are included: 

•  EDITING RECEIVER DEFAULTS 

•  EDITING BARRIER DEFAULTS 

•  EDITING ROADWAY DEFAULTS 

•     EDITING EQUIPMENT DEFAULTS 

•  EDITING TERRAIN LINE DEFAULTS 

•  EDITING BUILDING ROW DEFAULTS 

•  EDITING TREE ZONE DEFAULTS 

•  EDITING GROUND ZONE DEFAULTS 

•  EDITING CONTOUR ZONE DEFAULTS 
 

6.1 EDITING RECEIVER DEFAULTS 

The Edit Receiver Defaults Pane, shown in FIGURE 32, provides functions to edit defaults for all receivers 

that have not yet been added to the project. Default changes will not apply to receivers that have 

already been added to the project. 

To edit receiver defaults, click the Receiver icon   . 
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Figure 32 Edit Receiver Defaults Pane 

6.1.1 TO EDIT THE BASIC FEATURES OF RECEIVERS 

• Check or un‐check the Active checkbox to toggle the Active Receiver designation. 

• Enter or use the up/down arrows  in the fill box to change the number of Dwelling units 

represented by each receiver. 

• Enter or use the up/down arrows  in the fill box to change the Height of the receivers above 

the local ground. 

• Enter text in the fill box to change the Name of the receivers. 

• Enter text in the fill box to change any Notes about the receivers. 

6.1.2 TO EDIT THE LEVELS/CRITERIA FEATURES OF RECEIVERS 

• Enter or use the up/down arrows  in the fill box to change the Existing Level (ambient noise 

level). 

• Enter or use the up/down arrows  in the fill box to change the Impact Increase (relative to 

the Existing Level). 

• Enter or use the up/down arrows  in the fill box to change the Impact Level (absolute 

roadway noise level). 

• Enter or use the up/down arrows  in the fill box to change the Noise Reduction Goal for 

barrier design. 
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6.2 EDITING BARRIER DEFAULTS 

The Edit Barrier Defaults Pane, shown in FIGURE 33, provides functions to edit defaults for all barriers 

that have not yet been added to the project. Default changes will not apply to barriers that have already 

been added to the project. 

To edit barrier defaults, click the Barrier icon . 

  
Figure 33 Edit Barrier Defaults Pane 

6.2.1 TO EDIT THE BASIC FEATURES OF BARRIERS 

• Use the dropdown list to change the Barrier Type. Choose from Wall or Berm. 

• Enter or use the up/down arrows  in the fill box to change the Maximum Height to define the 

upper bound for input checking. 

• Enter or use the up/down arrows  in the fill box to change the Minimum Height to define the 

lower bound for input checking. 

• Enter text in the fill box to change the Name of the barriers. 

• Enter text in the fill box to change any Notes about the barriers. 
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6.2.2 TO EDIT THE WALL REFLECTION FEATURES OF BARRIERS 

• Enter or use the up/down arrows  in the fill box to change the Noise Reduction Coefficient 

for the barrier Left‐Side. 

• Enter or use the up/down arrows  in the fill box to change the Noise Reduction Coefficient 

for Parallel Barrier Analysis. 

• Enter or use the up/down arrows  in the fill box to change the Noise Reduction Coefficient 

for the barrier Right‐Side. 

6.2.3 TO EDIT THE SEGMENT FEATURES OF BARRIERS 

• Check or un‐check the checkbox to toggle the For Noise Abatement barrier designation.  

Note: This will impact the noise level results within and outside of the Barrier Analysis module. 

• Enter or use the up/down arrows  in the fill box to change the barrier segment Height. 

• Enter or use the up/down arrows  in the fill box to change the perturbation Increment Size. 

• Enter or use the up/down arrows  in the fill box to change the number of possible 

perturbations Down. 

• Enter or use the up/down arrows  in the fill box to change the number of possible 

perturbations Up. 

6.2.4 TO EDIT THE WALL UNIT COST FEATURES OF BARRIERS 

• Enter or use the up/down arrows  in the fill box to change the Area dollar amount per square 

unit. 

• Enter or use the up/down arrows  in the fill box to change the Lineal dollar amount per linear 

unit. 

6.3 EDITING ROADWAY DEFAULTS 

The Edit Roadway Defaults pane, shown in FIGURE 34, provides functions to edit defaults for all roadways 

that have not yet been added to the project. Default changes will not apply to roadways that have 

already been added to the project. 

To edit roadway defaults, click the Roadway icon . 
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Figure 34 Edit Roadway Defaults Pane 

6.3.1 TO EDIT THE BASIC FEATURES OF ROADWAYS 

• Use the dropdown list to change the Category label. Choose from Mainline, Ramp, or Shoulder. 

• Enter text in the fill box to change the Name of the roadways. 

• Enter text in the fill box to change any Notes about the roadways. 

• Check or un‐check the checkbox to toggle the On Structure designation for roadways. 

• Use the dropdown list to change the roadway surface. Choose from the following Pavement 

types: Average, Dense Graded Asphalt, Open Graded Asphalt, or Portland Concrete.  

Note: Average pavement is the only roadway surface type permitted for FHWA regulatory 

analyses. 

• Enter or use the up/down arrows  in the fill box to change the roadway Width to define the 

pavement ground zone extending perpendicularly from either side of the roadway object 

centerline. 

6.3.2 TO EDIT THE MULTI-LANE SETTINGS OF ROADWAYS 

• Check/un‐check the checkbox to enable/disable the Multi‐Lane tool for digitizing many lanes and 

shoulders simultaneously. 

• Check/un‐check the checkbox to enable/disable the creation of an Inside Shoulder within the 

Multi-Lane tool. 

• Enter or use the up/down arrows  in the fill box to change the Inside Shoulder Width to 
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define the pavement ground zone extending perpendicularly from either side of the roadway 

object centerline. 

• Enter or use the up/down arrows  in the fill box to change the Number of Lanes digitized by 

the Multi-Lane tool. 

• Check/un‐check the checkbox to enable/disable the creation of an Outside Shoulder within the 

Multi-Lane tool. 

• Enter or use the up/down arrows  in the fill box to change the Outside Shoulder Width to 

define the pavement ground zone extending perpendicularly from either side of the roadway 

object centerline. 

6.4 EDITING EQUIPMENT DEFAULTS 

The Edit Equipment Defaults pane, shown in FIGURE 35, provides functions to edit defaults for all 

equipment that have not yet been added to the project. Default changes will not apply to equipment 

that have already been added to the project. 

To edit equipment defaults, click the Equipment icon . 

 
Figure 35 Edit Equipment Defaults Pane 
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6.4.1 TO EDIT THE BASIC FEATURES OF EQUIPMENT OBJECTS 

• Enter text in the fill box to change the Name of the equipment. 

• Enter text in the fill box to change any Notes about the equipment. 

• Check or un‐check the checkbox to toggle the On Structure designation for equipment. 

6.4.2 TO EDIT THE EQUIPMENT SETTINGS 

• Use the dropdown list to change the Equipment Type. Choose from a list of 70 default 

equipment objects as well as any user defined equipment objects that have been added to the 

UserDefinedEquipment.csv file. See Section 2.4.1 of the TNM 3.2 Technical Manual (FHWA-HEP-

24-015) for more details on the default equipment. See Section 2.4.2 of the TNM 3.2 Technical 

Manual for instructions on inputting User Defined Equipment data.  

Note: Selection of an Equipment Type in the Edit Equipment Defaults pane will change the non-

editable Draw Type, Equipment Height, Equipment Operation, is Stationary, and is User Defined 

displays to reflect the equipment settings for the chosen object. 

• Enter or use the up/down arrows  in the fill box to change the Time Active (Hours) to 

establish the duration of noise generating activity for equipment. 

6.5 EDITING TERRAIN LINE DEFAULTS 

The Edit Terrain Line Defaults pane, shown in FIGURE 36, provides functions to edit defaults for all terrain 

lines that have not yet been added to the project. Default changes will not apply to terrain lines that 

have already been added to the project. 

To edit terrain line defaults, click the Terrain Line icon . 

  
Figure 36 Edit Terrain Line Defaults Pane 

6.5.1 TO EDIT THE BASIC FEATURES OF TERRAIN LINES 

• Enter text in the fill box to change the Name of the terrain lines. 

• Enter text in the fill box to change any Notes about the terrain lines. 
 

https://www.fhwa.dot.gov/environment/noise/traffic_noise_model/tnm_v32/
https://www.fhwa.dot.gov/environment/noise/traffic_noise_model/tnm_v32/
https://www.fhwa.dot.gov/environment/noise/traffic_noise_model/tnm_v32/
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6.6 EDITING BUILDING ROW DEFAULTS 

The Edit Building Row Defaults pane, shown in FIGURE 37, provides functions to edit defaults for all 

building rows that have not yet been added to the project. Default changes will not apply to building 

rows that have already been added to the project. 

To edit building row defaults, click the Building Row icon . 

  
Figure 37 Edit Building Row Defaults Pane 

6.6.1 TO EDIT THE BASIC FEATURES OF BUILDING ROWS 

• Enter text in the fill box to change the Name of the building rows. 

• Enter text in the fill box to change any Notes about the building rows. 

6.6.2 TO EDIT THE MEASUREMENTS FEATURES OF BUILDING ROWS 

• Enter or use the up/down arrows  in the fill box to change the Average building Height. 

• Enter or use the up/down arrows  in the fill box to change the Gap Percentage to designate 

the space between the buildings as a percent of the spatial extent of the building row. 

6.7 EDITING TREE ZONE DEFAULTS 

The Edit Tree Zone Defaults pane, shown in FIGURE 38, provides functions to edit defaults for all tree 

zones that have not yet been added to the project. Default changes will not apply to tree zones that 

have already been added to the project. 

To edit tree zone defaults, click the Tree Zone icon . 
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Figure 38 Edit Tree Zone Defaults Pane 

6.7.1 TO EDIT THE BASIC FEATURES OF TREE ZONES 

• Enter text in the fill box to change the Name of the tree zones. 

• Enter text in the fill box to change any Notes about the tree zones. 

6.7.2 TO EDIT THE GROUND INFO FEATURES OF TREE ZONES 

• Use the dropdown list to select or change the Ground Type beneath the trees. Choose from: 

Pavement, Water Hard Soil, Loose Soil, Lawn, Field Grass, Granular Snow, Powder Snow, or 

Custom. 

• If Custom Ground Type is selected, enter or use the up/down arrows  in the fill box to select 

the Flow Resistivity of the Ground Type. Otherwise, the value in this field will reset to the 

corresponding Flow Resistivity for the Ground Type selected. See Section 4.3.1 in the TNM 3.2 

Technical Manual (FHWA-HEP-24-015) for more details.  

6.7.3 TO EDIT THE MEASUREMENTS FEATURE OF TREE ZONES 

• Enter or use the up/down arrows  in the fill box to change the Average tree Height above the 

local ground. 

6.8 EDITING GROUND ZONE DEFAULTS 

The Edit Ground Zone Defaults pane, shown in FIGURE 39, provides functions to edit defaults for all 

ground zones that have not yet been added to the project. Default changes will not apply to ground 

zones that have already been added to the project. 

To edit ground zone defaults, click the Ground Zone icon . 

https://www.fhwa.dot.gov/environment/noise/traffic_noise_model/tnm_v32/
https://www.fhwa.dot.gov/environment/noise/traffic_noise_model/tnm_v32/
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Figure 39 Edit Ground Zone Defaults Pane 

6.8.1 TO EDIT THE BASIC FEATURES OF GROUND ZONES 

• Enter text in the fill box to change the Name of the ground zones. 

• Enter text in the fill box to change any Notes about the ground zones. 

6.8.2 TO EDIT THE GROUND INFO OF GROUND ZONES 

• Use the dropdown list to select or change the Ground Type of the ground zones. Choose from: 

Pavement, Water Hard Soil, Loose Soil, Lawn, Field Grass, Granular Snow, Powder Snow, or 

Custom. 

• If Custom Ground Type is selected, enter or use the up/down arrows  in the fill box to select 

the Flow Resistivity of the Ground Type. Otherwise, the value in this field will reset to the 

corresponding Flow Resistivity for the Ground Type selected. See Section 4.3.1 in the TNM 3.2 

Technical Manual (FHWA-HEP-24-015) for more details.  

6.9 EDITING CONTOUR ZONE DEFAULTS 

The Edit Contour Zone Defaults pane, shown in FIGURE 40, provides functions to edit defaults for all 

contour zones that have not yet been added to the project. Default changes will not apply to contour 

zones that have already been added to the project. 

To edit contour zone defaults, click the Contour Zones icon . 

https://www.fhwa.dot.gov/environment/noise/traffic_noise_model/tnm_v32/
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Figure 40 Edit Contour Zone Defaults Pane 

6.9.1 TO EDIT THE BASIC FEATURES OF CONTOUR ZONES 

• Enter text in the fill box to change the Name of the contour zones. 

• Enter text in the fill box to change any Notes about the contour zones. 

6.9.2 TO EDIT THE MEASUREMENTS FEATURES OF CONTOUR ZONES  

• Enter or use the up/down arrows  in the fill box to change the Height of the receiver Grid 

within the contour zones. 

• Enter or use the up/down arrows  in the fill box to change the Minimum Spacing between 

the receiver Grid within the contour zones. 

• Enter or use the up/down arrows  in the fill box to change the Tolerance value (the level 

difference between adjacent contour receiver levels required to split a grid cell). 
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7. EDIT PANE: SEARCH AND GEOCODE TABS 

The Edit Pane also contains the SEARCH TAB and GEOCODE TAB functions.  

7.1 SEARCH TAB 

The Search tab is used to find objects that currently exist within the open project. 

7.1.1 TO SEARCH FOR AN ITEM 

1. Enter the name of the desired object in the search bar. Suggestions populate as text is entered, 

as shown in FIGURE 41. 

2. Click the magnifying glass icon  or hit Enter on the keyboard to submit the search criteria. 

Results matching your search criteria display below the search bar. 

3. Click a result. The Plan Builder will refresh to center around the selected object. 

 
Figure 41 Search Sub-pane 

7.2 GEOCODE TAB 

The Geocode tab, shown in FIGURE 42 is used to locate points on the map by address and vice versa, to 

obtain addresses from points on the map. 

 
Figure 42 Geocode Sub-Pane 



TNM 3.2 User’s Guide 

 

 

Page 47 of 63 

7.2.1 TO LOCATE POINTS ON THE MAP 

1. Enter an address into the text field shown in FIGURE 42 Geocode Sub-Pane. 

2. Click the Geocode Address button or hit Enter on the keyboard to submit the address. Results 

matching your search criteria display below the Geocode Address and Clear buttons. 

3. Click to select an option from the results list. A geocode symbol appears in the Plan Builder. 

4. Click the Clear button to remove the geocode symbol from the Plan Builder.  

7.2.2 TO OBTAIN A GEOCODED ADDRESS 

1. Check the Pick from Map checkbox. The Enter Address field and Geocode Address button 

become disabled. 

2. Click in the Plan Builder. The geocode symbol appears in the Plan Builder and the address for 

that location displays in the Geocode tab. 

3. Click the Clear button in the Geocode tab to remove the geocode symbol from the Plan Builder. 
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8. OBJECT DETAILS PANE 

The Object Details Pane lists the data for each object that currently exists within the open project, as 

well as overall noise level results and informational messages. The data in the tabs for each object type 

will update to reflect changes made in the PLAN BUILDER. Vice versa, edits made in the Object Details Pane 

data grids will be reflected in the VIEW PANE. The tab menu for each type of information is shown in 

FIGURE 43. 

 
Figure 43 Object Details Pane Menu 

The Detail pane consists of the following sub‐panes: 

• RECEIVERS DETAIL SUB-PANE 

• BARRIERS DETAIL SUB-PANE 

• ROADWAYS DETAIL SUB-PANE 

• EQUIPMENT DETAIL SUB-PANE 

• TERRAIN LINES DETAIL SUB-PANE 

• BUILDING ROWS DETAIL SUB-PANE 

• TREE ZONES DETAIL SUB-PANE 

• GROUND ZONES DETAIL SUB-PANE 

• CONTOUR ZONES DETAIL SUB-PANE 

• USER-DEFINED VEHICLES DETAIL SUB-PANE 

• OUTPUT DETAIL SUB-PANE 

• PROJECT INFORMATION DETAIL SUB-PANE 

• ROADWAY RESULTS DETAIL SUB-PANE 

• EQUIPMENT RESULTS DETAIL SUB-PANE 

• VALIDATION RESULTS DETAIL SUB-PANE  

8.1 DATA ENTRY TIPS 

TNM provides multiple techniques and tools that assist users in entering the attribute values in the 

Object Details Pane to reduce the time necessary to set up complex models. Here are a few tips: 

• When editing roadway traffic data in the ROADWAYS DETAIL SUB-PANE, TNM 3.2 allows users to 

click the ‘Copy Down’ button to apply repetitive traffic attributes to all subsequent data grid 

rows for each roadway segment. 

• The easiest way to create objects with many points is to use the mouse to arbitrarily create an 

object with the correct number of points, while not worrying about the geometry. All input 

tables in TNM 3.2 can accept values copied from a spreadsheet, apart from the Roadways Traffic 

tab in the ROADWAYS DETAIL SUB-PANE.  

Note: With a large number of coordinates to replace, it may take a minute or two for TNM to 

update all the data.  

A simple means of copy and pasting data into TNM 3.2 is as follows: 

1. Click in the Object Details Pane table of interest in TNM 

2. Key ‘Ctrl + A’ to select the entire data table contents (all cells will appear highlighted when 

complete) 
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3. Key ‘Ctrl + C’ to copy the entire data table contents 

4. Key ‘Ctrl + V’ to paste the entire data table contents into an external spreadsheet (doing so 

will display TNM’s expected data format for each column) 

5. Modify the spreadsheet contents as desired while maintaining the expected format 

6. Copy the entire modified spreadsheet table contents 

7. Click in the Object Details Pane table of interest in TNM 

8. Key ‘Ctrl + A’ to select the entire data table (all cells will appear highlighted when complete) 

9. Key ‘Ctrl + V’ to paste the entire modified spreadsheet table contents into TNM.  

Note: Any Sequence or Point Numbers that may have been changed in the spreadsheet will 

not be reflected when pasted into the Object Details Pane because they are fixed quantities 

within TNM. However, their column is a required part of any spreadsheet used to manipulate 

data outside of TNM in order to maintain the expected format when pasting back into TNM. 

• For QA/QC, TNM 3.2 allows users to easily sort and filter data entered in all Object Details Pane 

data grids as well as the Barrier Analysis Tables in the Barrier Analysis Module. For example, this 

feature can be used to catch objects with non-unique names or other undesirable data 

attributes.  

Note: Any data sorting or filtering will not be retained when reopening the project in a future 

TNM session.  

Users may take advantage of the sorting and filtering capabilities with the following methods: 

o Click the column header to sort data grids by the value of a single column. The column 

header will become highlighted to indicate the sorting parameter. 

o Hold down the ‘Shift’ key on the keyboard and click to select the desired column 

headers for sorting data grids by the value of multiple columns at once. The column 

header will become highlighted to indicate the sorting parameter. 

o Click on the funnel icon to the right of the column header text to open the filter menu 

for each data column.  

Note: Data from multiple columns can be filtered at once using the filter menu. The 

funnel icon in the column header will become highlighted to indicate the data have been 

filtered using a parameter pertaining to the respective column. 

8.2 DATA EXPORT TIP 

The data tables in the Object Details Pane and Barrier Analysis Module can be exported to .csv files at 

any time.  

Note: Once saved, these files will not update to reflect any future changes made in the TNM application. 

To export Object Details Pane or Barrier Analysis table data: 

1. Click the Excel symbol in the bottom right corner of the desired table. A file explorer window 

opens. 

2. Navigate to the desired output file directory in the file explorer window. 

3. Enter the desired output file name in the file explorer window. 

4. Click Save in the file explorer window to write the file. 

5. Click Cancel in the file explorer window at any time to abandon exporting the table data. 
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8.3 RECEIVERS DETAIL SUB-PANE 

The Receivers Detail sub‐pane contains the data for each receiver that currently exists within the open 

project. Users can view and edit the general settings, Levels/Criteria, and Adjustment Factors of each 

receiver by clicking the respective tabs in the left column of the Receivers detail sub-pane.  

Note: Sequence Numbers cannot be edited. 

8.4 BARRIERS DETAIL SUB-PANE 

The Barriers Detail sub‐pane contains the data for each barrier that currently exists within the open 

project. Users can view and edit the general settings, Points, Segments, Structure, and Reflections of 

each barrier by clicking the respective tabs in the left column of the Barriers details sub-pane.  

Note: The Point Numbers as well as the On Structure and Reflections checkboxes cannot be edited.  

Click the “Edit” button in the Textual Pairing column of the Structure or Reflections tab to open the 

respective dialog box for pairing barrier and roadway segments. Once a barrier segment is paired, the 

respective On Structure or Reflections checkbox will appear checked. See the TNM 3.2 FAQs (FHWA-

HEP-24-013) for more details. 

8.5 ROADWAYS DETAIL SUB-PANE 

The Roadways Detail sub‐pane contains the data for each roadway that currently exists within the open 

project. Users can view and edit the general settings, Points, Segments, Traffic, and Flow Control of each 

roadway by clicking the respective tabs in the left column of the Roadways details sub-pane. See the 

TNM 3.2 FAQs (FHWA-HEP-24-013) for more details.  

Note: Point Numbers cannot be edited. 

8.6 EQUIPMENT DETAIL SUB-PANE 

The Equipment Detail sub‐pane contains the data for each equipment object that currently exists within 

the open project. Users can view and edit the general settings, Points, and Segments of each equipment 

object by clicking the respective tabs in the left column of the Equipment details sub-pane. See the TNM 

3.2 FAQs (FHWA-HEP-24-013) for more details.  

Note: The Equipment Type, Equipment Operation, Equipment Height, Equipment Stationary, Is User 

Defined, and Point Numbers cannot be edited as they are properties inherent to each equipment object. 

See Section 2.4.2 of the TNM 3.2 Technical Manual for instructions on inputting User Defined Equipment 

data. 

8.7 TERRAIN LINES DETAIL SUB-PANE 

The Terrain Lines Detail sub‐pane contains the data for each terrain line that currently exists within the 

open project. Users can view and edit the general settings, Points, and Segments of each terrain line by 

clicking the respective tabs in the left column of the Terrain Lines detail sub-pane.  

Note: Point Numbers cannot be edited. 

https://www.fhwa.dot.gov/environment/noise/traffic_noise_model/tnm_v32/
https://www.fhwa.dot.gov/environment/noise/traffic_noise_model/tnm_v32/
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8.8 BUILDING ROWS DETAIL SUB-PANE 

The Building Rows Detail sub‐pane contains the data for each building row that currently exists within 

the open project. Users can view and edit the general settings, Points, and Segments of each building 

row by clicking the respective tabs in the left column of the Building Rows detail sub-pane.  

Note: Point Numbers cannot be edited. 

8.9 TREE ZONES DETAIL SUB-PANE 

The Tree Zones Detail sub‐pane contains the data for each tree zone that currently exists within the 

open project. Users can view and edit the general settings, Points, and Segments of each tree zone by 

clicking the respective tabs in the left column of the Tree Zones details sub-pane.  

Note: Point Numbers cannot be edited.  

8.10 GROUND ZONES DETAIL SUB-PANE 

The Ground Zones Detail sub‐pane contains the data for each ground zone that currently exists within 

the open project. Users can view and edit the general settings, Points, and Segments for each ground 

zone by clicking the respective tabs in the left column of the Ground Zones details sub-pane.  

Note: Point Numbers cannot be edited. 

8.11 CONTOUR ZONES DETAIL SUB-PANE 

The Contour Zones Detail sub‐pane contains the data for each contour zone that currently exists within 

the open project. Users can view and edit the general settings, Points, and Segments of each contour 

zone by clicking the respective tabs in the left column of the Contour Zones details sub-pane.  

Note: Point Numbers cannot be edited. 

8.12 USER-DEFINED VEHICLES DETAIL SUB-PANE 

The User Defined Vehicles Detail sub‐pane contains the data for each user defined vehicle that currently 

exists within the open project. Users can view and edit the user defined vehicles general settings here. 

8.13 OUTPUT DETAIL SUB-PANE 

The Output Detail sub‐pane is an application log that provides a running list of the user commands as 

well as processes that were initiated and executed during the current TNM session. The Output detail 

sub-pane also includes the timestamps for the user commands as well as processes initiation and 

execution. 

8.14 PROJECT INFORMATION DETAIL SUB-PANE 

The Project Information detail sub‐pane lists the project metadata for the open project. 

8.15 ROADWAY RESULTS DETAIL SUB-PANE 
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The Roadway Results detail sub‐pane lists the calculation results of the roadway noise model operations 

for the open project after the receiver calculations have been generated using the functions in the 

Toolbar CALCULATE TAB.  

Note: When input changes are made, previously calculated results are reset and the data in this sub-

pane will disappear. 

8.16 EQUIPMENT RESULTS DETAIL SUB-PANE 

The Equipment Results detail sub‐pane lists the calculation results of the construction noise model 

operations for the open project after the receiver calculations have been generated using the functions 

in the Toolbar CALCULATE TAB.  

Note: When input changes are made, previously calculated results are reset and the data in this sub-

pane will disappear. 

8.17 VALIDATION RESULTS DETAIL SUB-PANE 

The Validation Results detail sub‐pane lists the input check error and warning messages for the open 

project before the receiver calculations are generated. The data in this sub-pane will disappear after 

addressing the disallowed inputs and initiating a new input check or receiver calculation using the 

functions in the Toolbar CALCULATE TAB. See the TNM 3.2 FAQs (FHWA-HEP-24-013) for more details.  

https://www.fhwa.dot.gov/environment/noise/traffic_noise_model/tnm_v32/


TNM 3.2 User’s Guide 

 

 

Page 53 of 63 

9. DRAWING IN THE PLAN BUILDER 

In order to calculate noise levels affecting a specific area, TNM objects must be added to the project. 

Objects that can be drawn in the Plan Builder are as follows: 

• ADDING RECEIVERS TO THE PROJECT  

• ADDING BARRIERS TO THE PROJECT 

• ADDING ROADWAYS TO THE PROJECT 

• ADDING EQUIPMENT TO THE PROJECT 

• ADDING TERRAIN LINES TO THE PROJECT 

• ADDING BUILDING ROWS TO THE PROJECT 

• ADDING TREE ZONES TO THE PROJECT 

• ADDING GROUND ZONES TO THE PROJECT 

• ADDING CONTOUR ZONES TO THE PROJECT  

Note: There are rules regarding which objects can and cannot coincide in TNM. See Appendix H of the 

TNM 3.2 Technical Manual for a comprehensive list of input object intersection rules and rationale. 

9.1 ADDING RECEIVERS TO THE PROJECT 

At least one receiver must be added to the project to define the location at which to compute noise 

levels. Users may add as many receivers as desired to ensure coverage of all appropriate noise analysis 

locations. However, limiting the number of receiver locations will help manage calculation runtimes. See 

the TNM 3.2 FAQs (FHWA-HEP-24-013) for more information. 

9.1.1 TO ADD A RECEIVER 

1. Click the Receiver icon    in the Edit Pane. The Receiver Defaults window appears. 

2. Press the "D" key on the keyboard or click the Enable Object Add button in the SHARED TOOLS 

FUNCTION. 

3. Click in the Plan Builder at the desired receiver location. A blue square appears at that point 

indicating that a receiver has been applied. An example is shown in FIGURE 44. 

4. To delete the receiver, right click on the receiver point and select Delete from the menu options. 

https://www.fhwa.dot.gov/environment/noise/traffic_noise_model/tnm_v32/
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Figure 44 Added Receivers in the Plan Builder 

After a receiver has been added to the project, the attributes of the receiver can be edited in the 

RECEIVERS DETAIL SUB-PANE. 

9.2 ADDING BARRIERS TO THE PROJECT 

Barriers can be added to the project to account for line-of-sight blockage resulting in noise abatement. 

Barriers segment heights can be adjusted to produce the desired level of noise abatement. However, 

limiting the number of perturbations will help manage calculation runtimes. See the TNM 3.2 FAQs 

(FHWA-HEP-24-013) for more information. 

9.2.1 TO ADD A BARRIER 

1. Click the Barrier icon in the Edit Pane. The Barrier Defaults window appears. 

2. Press the "D" key on the keyboard or click the Enable Object Add button in the SHARED TOOLS 

FUNCTION. 

3. Click in the Plan Builder at the desired starting location for the barrier. A blue line will appear as 

drawing continues.  

Note: Barrier direction is defined relative to the start and end points. 

4. Click as many mid‐points as desired to draw the barrier. 

5. Double click the end point location for the barrier. A solid, red, directional line with red circles 

appears in the Plan Builder showing the starting point, mid‐points, and end point indicating the 

barrier has been applied. An example is shown in FIGURE 45. 

6. To delete the barrier, right click on the barrier and select Delete from the menu options. 

https://www.fhwa.dot.gov/environment/noise/traffic_noise_model/tnm_v32/
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Figure 45 An Added Barrier in the Plan Builder 

After a barrier has been added to the project, the attributes of the barrier can be edited in the BARRIERS 

DETAIL SUB-PANE. 

9.3 ADDING ROADWAYS TO THE PROJECT 

To compute traffic noise levels, at least one roadway must be added to the project to define the source. 

Roadway noise changes with respect to attributes including traffic volume and speed of each vehicle 

type, vehicle acceleration due to flow control and roadway grade, as well as roadway geometry relative 

to the receivers and intervening objects. 

9.3.1 TO ADD A ROADWAY 

1. Click the Roadway icon  in the Edit Pane. The Roadway Defaults window appears. 
2. Press the "D" key on the keyboard or click the Enable Object Add button in the SHARED TOOLS 

FUNCTION. 

3. Click in the Plan Builder at the desired starting location of the roadway. A blue line will appear 

as drawing continues.  

Note: Roadway direction is defined relative to the start and end points. 

4. Click as many mid‐points as desired to draw the roadway. 

5. Double click the end point location for the roadway. A solid, black, directional line with black 

circles appears in the Plan Builder showing the starting point, mid‐points, and end point 

indicating the roadway has been applied. An example is shown in FIGURE 46. 

6. To reverse the direction of travel, right click on the roadway and select Reverse Direction from 

the menu options. After doing so, check to make sure the roadway attributes are still set as 

desired in the ROADWAYS DETAIL SUB-PANE. 
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7. To delete the roadway, right click on the roadway and select Delete from the menu options.  

Note: For multiple lane roads, individual roadways should be added equaling the number of lanes on the 

actual road in the correct direction of traffic flow. 

 
Figure 46 Added Roadways in the Plan Builder 

After a roadway has been added to the project, the attributes of the roadway can be edited in the 

ROADWAYS DETAIL SUB-PANE. 

9.4 ADDING EQUIPMENT TO THE PROJECT 

To compute construction noise levels, an Equipment object must be added to the project to define the 

source. Each Equipment object that is added must be applied directionally (i.e., if a construction site has 

moving construction equipment, the path of travel must be added to the map; if a construction site has 

non-moving construction equipment, the directionality must be added to the map by defining the 

equipment orientation). In addition to directionality, construction noise changes with respect to 

attributes including the source spectra and height of each equipment object, as well as the duration of 

noise generating activity. 

9.4.1 TO ADD A STATIONARY EQUIPMENT OBJECT 

1. Click the Equipment icon  in the Edit Pane. The Equipment Defaults window appears. 

2. Use the Equipment Type dropdown list under Equipment Settings to select an object such that 

the non-editable Draw Type displays ‘Point’.  

Note: Default and User Defined Equipment objects will be included in this list. See Section 2.4.2 

of the TNM 3.2 Technical Manual (FHWA-HEP-24-015) for instructions on inputting User 
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Defined Equipment data. 

3. Press the "D" key on the keyboard or click the Enable Object Add button in the SHARED TOOLS 

FUNCTION. 

4. Click in the Plan Builder at the desired location of the stationary equipment. A blue line will 

appear as drawing continues. 

5. Click a secondary point in the Plan Builder to define the direction of the ‘front’ of the 

stationary equipment object and apply the stationary equipment object to the map. A golden-

brown dotted line terminated on one end by a yellow and black striped square and on the 

other end by a black arrow appears in the Plan Builder, indicating the stationary equipment 

has been added. The yellow and black striped square represents the stationary equipment 

location. The dotted line and black arrow illustrate the orientation of the stationary 

equipment. An example is shown in FIGURE 47. 

6. To delete the stationary equipment object, right click on the stationary equipment object and 

select Delete from the menu options. 

 
Figure 47 An Added Stationary Equipment Object in the Plan Builder 

After an equipment object has been added to the project, the attributes of the equipment can be edited 

in the EQUIPMENT DETAIL SUB-PANE. 

9.4.2 TO ADD A NON-STATIONARY EQUIPMENT OBJECT 

1. Click the Equipment icon  in the Edit Pane. The Equipment Defaults window appears. 

2. Use the Equipment Type dropdown list under Equipment Settings to select an object such that 

the non-editable Draw Type displays ‘PolyLine’.  

Note: Default and User Defined Equipment objects will be included in this list. See Section 2.4.2 

of the TNM 3.2 Technical Manual (FHWA-HEP-24-015) for instructions on inputting User 
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Defined Equipment data. 

3. Press the "D" key on the keyboard or click the Enable Object Add button in the SHARED TOOLS 

FUNCTION. 

4. Click in the Plan Builder at the desired starting location of the non-stationary equipment. A 

blue line will appear as drawing continues.  

Note: Non-stationary equipment direction is defined relative to the start and end points. 

5. Click as many mid‐points as desired to draw the non-stationary equipment object. 

6. Double click the end point location for the non-stationary equipment. A solid, golden-brown, 

directional line with yellow and black striped squares appear on the map showing the starting 

point, mid‐points, and end point indicating the equipment has been applied. An example is 

shown in FIGURE 48. 

7. To reverse the direction of travel, right click on the non-stationary equipment object and 

select Reverse Direction from the menu options. 

8. To delete the non-stationary equipment object, right click on the non-stationary equipment 

object and select Delete from the menu options. 

 
Figure 48 An Added Non-Stationary Equipment Object in the Plan Builder 

After an equipment object has been added to the project, the attributes of the equipment can be edited 

in the EQUIPMENT DETAIL SUB-PANE. 

9.5 ADDING TERRAIN LINES TO THE PROJECT 

Terrain lines define points along the ground profile of a TNM project for geophysical features such as 
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hills or valleys. See the TNM 3.2 FAQs (FHWA-HEP-24-013) for more information. The ground profile in 

TNM provides attenuation via acoustic shielding. 

9.5.1 TO ADD A TERRAIN LINE 

1. Click the Terrain Line icon  in the Edit Pane. The Terrain Line Defaults window appears. 

2. Press the "D" key on the keyboard or click the Enable Object Add button in the SHARED TOOLS 

FUNCTION. 

3. Click in the Plan Builder at the desired starting location of the terrain line. A blue line will 

appear as drawing continues. 

4. Click as many mid‐points as desired to draw the terrain line. 

5. Double click the end point location for the terrain line. A solid, nondirectional, green line and 

red circles appears in the Plan Builder indicating the terrain line has been applied. An example 

is shown in FIGURE 49. 

6. To delete the terrain line, right click on the terrain line and select Delete from the menu 

options. 

 
Figure 49 An Added Terrain Line in the Plan Builder 

After a terrain line has been added to the project, the attributes of the terrain line can be edited in the 

TERRAIN LINES DETAIL SUB-PANE. 

9.6 ADDING BUILDING ROWS TO THE PROJECT 

Building rows are used to represent the acoustic shielding from the built environment. Building rows 

provide partial attenuation due to gaps between buildings such that line of sight is not completely 
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blocked between source and receivers. 

9.6.1 TO ADD A BUILDING ROW 

1. Click the Building Rows icon  in the Edit Pane. The Building Row Defaults window appears. 

2. Press the "D" key on the keyboard or click the Enable Object Add button in the SHARED TOOLS 

FUNCTION. 

3. Click in the Plan Builder at the desired starting location of the building row. A blue line will 

appear as drawing continues. 

4. Click as many mid-points as desired to draw the building row. 

5. Double click the end point location for the building row. A dotted, red, nondirectional line with 

red circles appears in the Plan Builder indicating the Building Row has been applied. An 

example is shown in FIGURE 50. 

6. To delete the building row, right click on the building row and select Delete from the menu 

options. 

 
Figure 50 An Added Building Row in the Plan Builder 

After a building row has been added to the project, the attributes of the building row can be edited in 

the BUILDING ROWS DETAIL SUB-PANE.  

9.7 ADDING TREE ZONES TO THE PROJECT 

Tree zones are used to represent the acoustic shielding from thick, dense foliage and thick undergrowth. 

9.7.1 TO ADD A TREE ZONE 

1. Click the Tree Zones icon  in the Edit Pane. The Tree Zone Defaults window appears. 

2. Press the "D" key on the keyboard or click the Enable Object Add button in the SHARED TOOLS 
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FUNCTION. 

3. Click in the Plan Builder at the desired starting location of the tree zone. A light blue polygon 

outlined with dark blue lines will appear as drawing continues. 

4. Click as many vertices as desired to draw the tree zone. 

5. Double click the end point location for the tree zone. A green polygon with a dotted grey 

perimeter and red circular vertices appears in the Plan Builder indicating the tree zone has 

been applied. An example is shown in FIGURE 51. 

6. To delete the tree zone, right click on the tree zone and select Delete from the menu options. 

  
Figure 51 An Added Tree Zone in the Plan Builder 

After a tree zone has been added to the project, the attributes of the tree zone can be edited in the TREE 

ZONES DETAIL SUB-PANE. 

9.8 ADDING GROUND ZONES TO THE PROJECT 

Ground zones are used to define the ground material in the area of interest (superseding the default 

ground type defined in the PROJECT SETTINGS FUNCTION). Each ground material has unique acoustic 

characteristics that apply when calculating noise levels. For example, a grass covered area provides 

greater attenuation than a paved area. 

9.8.1 TO ADD A GROUND ZONE 

1. Click the Ground Zone icon  in the Edit Pane. The Ground Zone Defaults window 

appears. 

2. Press the "D" key on the keyboard or click the Enable Object Add button in the SHARED TOOLS 
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FUNCTION. 

3. Click in the Plan Builder at the desired starting location of the ground zone. A light blue 

polygon outlined with dark blue lines will appear as drawing continues. 

4. Click as many vertices as desired to draw the ground zone. 

5. Double click the end point location for the ground zone. A grey polygon with a solid grey 

perimeter and red circular vertices appears in the Plan Builder indicating the ground zone has 

been applied. An example is shown in FIGURE 52. 

6. To delete the ground zone, right click on the ground zone and select Delete from the menu 

options. 

 
Figure 52 An Added Ground Zone in the Plan Builder 

After a ground zone has been added to the project, the attributes of the ground zone can be edited in 

the GROUND ZONES DETAIL SUB-PANE. 

9.9 ADDING CONTOUR ZONES TO THE PROJECT 

Contour zones define areas for TNM to compute sound level computations using a grid of receivers. The 

calculation results display gradations of sound level change within the spatial extent of the contour 

zone. 

9.9.1 TO ADD A CONTOUR ZONE 

1. Click the Contour Zone icon  in the Edit Pane. The Contour Zone Defaults window 

appears. 

2. Press the "D" key on the keyboard or click the Enable Object Add button in the SHARED TOOLS 

FUNCTION. 

3. Click in the Plan Builder at the desired starting location of the contour zone. A light blue 
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polygon outlined with dark blue lines will appear as drawing continues. 

4. Click as many vertices as desired to draw the contour zone. 

5. Double click the end point location for the contour zone. A blue polygon with a solid grey 

perimeter and red circular vertices appears in the Plan Builder indicating the contour zone has 

been applied. An example is shown in FIGURE 53. 

6. To delete the contour zone, right click on the contour zone and select Delete from the menu 

options. 

  
Figure 53 An Added Contour Zone in the Plan Builder 

After a contour zone has been added to the project, the attributes of the contour zone can be edited in 

the CONTOUR ZONES DETAIL SUB-PANE. 
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